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ABSTRACT

 This thesis focuses on experimental structural analysis using contemporary testing 

techniques. This includes modal testing topics such as data acquisition, data processing, 

sensor placement, and multiple excitation methods. It also presents a novel sensor placing 

procedure that uses a laser vibrometer to identify key sensor locations. These techniques 

are applied in a case study on a small unmanned aerial system, (UAS). The airframe, the 

BTE Super Hauler, is a small UAS used by the Unmanned Aircraft Systems Engineering 

(UASE) Laboratory at the University of North Dakota as a test platform for flight testing 

multiple payloads. An antenna system, designed for use in sense and avoid applications, 

was developed that requires the addition of wing pods to the current airframe to minimize 

electro-magnetic interference from the engine of the UAS. Modal testing is used to 

determine the effect of two wing pods on the structural dynamic behavior of the UAS. 

Flutter analysis is also performed to ensure that the surface bending and torsional modes 

of the UAS do not create an unstable airframe. 

 Data acquisition was performed using ModalVIEW, a structural analysis program 

supported by LabVIEW. ModalVIEW outputs a frequency response function to which 

various windowing methods can be applied. The aircraft was excited both by an impact 

hammer and a shaker. 



   

xix 

 The new sensor placement procedure was developed to assist in placing sensors in 

key locations in an efficient method to reduce the number of channels needed. It is also a 

fast, non-contact method implementing a laser vibrometer. A statistical method was used 

to determine appropriate sensor locations. 
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CHAPTER I 

INTRODUCTION

Description of Project 

 Modal analysis is the study of the vibration modes and natural frequencies of a 

structure. Modal analysis is essential to a full understanding of a structure's vibration 

characteristics. This is an especially important step in the development of aircraft as 

vibration can be a large factor in the safety and structural integrity. Not only should 

modal analysis be performed in the development of a new aircraft, but it is necessary 

when structural changes are made on an existing aircraft. 

 Modal analysis on a small Unmanned Aircraft System (UAS) was made necessary 

by the addition of wing pods. Modal analysis was performed both with and without the 

wing pods and the results were compared to identify the effect the wing pods have on the 

vibration characteristics of the UAS. The UAS with the wing pods installed can be seen 

in Figure 1. 
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Figure 1. Small unmanned aircraft system with wing pods installed (wing pods circled). 

 

 It is desirable to use as few sensors as possible in modal analysis. Because of this, 

channel reduction was investigated as well. Several tests were performed that had 

different types and levels of channel reduction and the results were compared to a base 

test to analyze which setups still captured all of the necessary information. 

 There are several existing sensor placement techniques but they generally use 

complex and time consuming models. A novel experimental sensor placement method 

was developed that uses a laser vibrometer to quickly and easily identify important sensor 

locations. Important sensor locations were identified from the laser vibrometer data 

through the use of a Pareto diagram. 

Need for Project 

 As UAS are being integrated into the National Air Space it is important that steps 

be taken to develop and implement sense and avoid systems into said UAS [1]. These 

systems are necessary to enable UAS to sense and avoid obstacles such as uncooperative 

aircraft, birds, power lines, buildings, and other obstacles [2]. 
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 The Unmanned Systems Aircraft Engineering (UASE) team at the University of 

North Dakota has done work in the field of sense and avoid systems for small UAS. One 

system that was developed uses an Automatic Dependent Surveillance-Broadcast (ADS-

B) transponder to track cooperative aircraft that also have ADS-B transponders. This 

system works well to predict and avoid collision scenarios with cooperative aircraft but 

doesn't assist in sense and avoid applications for uncooperative obstacles. Because of 

this, work is also being done on a small phased array radar system that can be installed 

into the small UAS along with the ADS-B to provide the ability to track uncooperative 

obstacles as well as cooperative.  

 This phased array radar system includes an antenna that locates objects by 

radiating a narrow beam of electromagnetic energy in the direction of interest [2]. This 

beam is also steerable so that it can locate objects at all locations around the UAS. 

Because this antenna radiates electromagnetic energy, it needs to have a clear field of 

view, containing no metal components, between it and its target [3]. This introduces a 

need to mount the antennas on the wings to reduce the effect of the engine, landing gear, 

and assorted fuselage components that could block the view of the antennas if mounted in 

the fuselage. An illustration of this is shown in Figure 2. The use of wing pods reduces 

any unwanted view interference and provides a payload bay on the wings in which to 

mount the antennas. 
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Figure 2. Uninterrupted field of view from mounting antennas on the wings. 

 

 The wing pods can dramatically change the structural and flight characteristics of 

the aircraft. This change in the characteristics could result in the introduction of flutter, a 

potentially catastrophic phenomenon where the aerodynamic forces drive bending and 

torsion motion on a flight surface. This behavior can be observed through experimental 

structural analysis. Therefore, a study on the structural analysis of the Super Hauler, both 

with and without the wing pods installed, is necessary to prove airworthiness of the 

modified aircraft. An in-depth discussion on flutter can be found in Chapter VI. 

Unmanned Aircraft Systems Engineering 

 The UASE team consists of a combination of undergraduate and graduate 

students in mechanical engineering and electrical engineering. The purpose of the lab is 

to design, build, and test payloads for UAS.  
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Figure 3. Unmanned Aircraft System Engineering team with the UAS they operate. 

 

 UASE has performed over 80 missions and has developed payloads relating to 

phased array radar, search and rescue, precision agriculture, sense and avoid, laser 

communications, and more. Flight testing is performed at Camp Grafton South, a military 

training facility in central North Dakota. This facility has restricted airspace, allowing 

UASE to safely and legally operate its UAS fleet. 

 UASE operates multiple UAS, one of which is the Bruce Tharpe Engineering 

Super Hauler, (henceforth referred to as the Super Hauler). The Super Hauler is the red 

and white aircraft in Figure 3 and is a gas powered UAS constructed of plywood, balsa 

wood, and Monokote. It has a 12 foot wingspan and a dry weight of 48 pounds. The 

engine is a 2-cylinder, 9.8 horsepower Desert Aircraft engine. The Super Hauler is 

capable of carrying payloads that weigh up to 30 pounds and has an electromagnetically 

shielded payload bay measuring 21 inches by 11 inches by 12 inches which can be seen 

in Figure 4. 
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Figure 4. Payload bay in the Super Hauler. 

 

 The following chapters will discuss the modal testing performed on the Super 

Hauler. Chapter 2 will discuss in detail the test setup and procedure of the modal tests. 

Chapter 3 presents the results from the modal testing using a base model of the Super 

Hauler. Chapter 4 enters into a study on channel reduction and examines several different 

tests that were performed to analyze the effects of channel reduction. A novel sensor 

location identification method is presented in Chapter 5. Finally, the effects of the wing 

pods on the airworthiness of the Super Hauler are discussed in Chapter 6. 
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CHAPTER II 

TEST OVERVIEW

Theory 

 The structural modes and natural frequencies of a structure can be obtained 

through ground vibration tests (GVTs). GVTs are important tests to perform on an 

aircraft because they are used to predict flutter and asses the significance of modifications 

made to the structure [4]. 

 The main tool used in a GVT is the frequency response function (FRF). This 

function can be based on the displacement, velocity, or acceleration response of a system 

to an applied force [5]. The expression for any FRF can be written as 

             (1) 

where Xj is the harmonic response in one of the degrees of freedom, j, caused by Fk 

which is a harmonic force at a different degree of freedom, k [6]. Modal analysis is 

performed by curve-fitting the FRF obtained from the testing to obtain modes then 

applying that data to a model of the structure to find the associated mode shapes. 

 A method of checking the quality of a mode is the Modal Assurance Criterion 

(MAC). It is mainly used to compare mode shapes obtained from experiments to those 

from analytical models such as finite element models [7]. The MAC represents the 
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normalized least squares deviation from the best straight line fitted to the data of 

corresponding vector entries in the mode shapes [8]. The value of the MAC can be 

calculated from 

                                    (2) 

where ϕmj is a measured mode and ϕak is an analytical mode [7]. The MAC varies from 0 

to 1 where 0 indicates no correspondence and 1 indicates consistent correspondence [9].  

Wing Pod Design 

 As stated previously, the modal analyses were made necessary by the addition of 

wing pods to the Super Hauler. The wing pods used to hold the antennas were designed 

and built by members of UASE. The pods are made entirely of polycarbonate to 

eliminate any electromagnetic interference [3]. The aerodynamic shape of the pods 

results in less drag which decreases the effect of the pods on flight performance.  

 
Figure 5. Side view of wing payload pod. 
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Figure 6. Wing payload pod with antenna array installed. 

 

The payload pods mount at the intersections of the wing segments using an aluminum 

mounting rib that follows the contour of the wing at this location. The overall dimensions 

of the pods are 7.75 inches long by 11 inches wide by 2.5 inches deep and each pod can 

carry up to 5 pounds.  

 
Figure 7. Wing pods installed in the Super Hauler. 
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The pods will most often be used in pairs to equalize the wing loading and provide a 

symmetric load on the airframe. Any electrical and power connectors and wiring will be 

routed inside of the wing to keep them out of the airflow over the wing. 

Testing Setup 

 The Super Hauler was isolated by suspending it on bungee cords in a test rig so 

that all the wheels were 1.25 inches off of the ground. This setup simulates a free-free 

boundary condition for modal testing [10]. The Super Hauler was then instrumented with 

uni-axial and tri-axial accelerometers in key locations. The instrumented Super Hauler in 

the test rig can be seen in Figure 8. 

 
Figure 8. The Super Hauler in the test rig while instrumented with accelerometers. 
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 Excitation of the Super Hauler was achieved by a small shaker. The shaker that 

was used was the Mini SmartShaker™ with an integrated power amplifier from The 

Modal Shop Inc. The setup of the shaker can be seen in Figure 9 where it was attached to 

the aircraft through the use of a suction cup.  

 
Figure 9. The shaker setup with stinger, load cell, and suction cup. 

 

A load cell was attached in line with the shaker's stinger to measure input force. The 

aircraft was excited at several different locations, all in the Z direction, that are identified 

by the red dots in Figure 10. 
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Figure 10. Shaker excitation locations. 

 

 The accelerometers and excitation devices were routed through a National 

Instruments data acquisition board that was connected directly to a computer. This board 

can be seen in Figure 11. 

 
Figure 11. National Instruments cDAQ-9178 data acquisition board used for the testing 
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Data capture and analysis was performed using ModalVIEW, a software designed 

specifically for modal testing and analysis. Information on the equipment that was used is 

shown in Table 1. 

Table 1. Test equipment information. 

Description Model Sensitivity Resolution 

Uni-axial Accelerometer PCB Piezotronics 352C18 10 mV/g 0.0005 g 

Uni-axial Accelerometer PCB Piezotronics 352C33  100 mV/g 0.00015 g 

Tri-axial Accelerometer PCB Piezotronics 356A32 100 mV/g 0.0003 g 

Load Cell PCB Piezotronics 208C02 50 mV/g 0.0004 g 

Shaker The Modal Shop Inc. K2007E01 - - 

Data Acquisition Board National Instruments cDAQ-9178 - - 

Data Acquisition Module National Instruments 9234  - - 

 

 Tests were performed with and without the wing pods installed. For all of the tests 

with the pods, weight was added to the pods so that a total weight of 5 pounds was 

attached to each wing. There was no payload in the payload bay during the testing. 

Test Procedure 

 The settings in ModalVIEW were as follows. The shaker was set to random 

excitation with an amplitude setting of 0.3 with a Hanning window applied. The 

amplitude of excitation was chosen to be an amplitude that provided enough excitation 

while not being so large that it would cause damage to the shaker or the aircraft. The 

measurement type was set to FRF-EMA for an experimental modal analysis. The 

sampling rate was left at the default of 1651.61 Hz with the resolution set to 0.1 Hz. 

ModalVIEW automatically selects a sampling duration based on the resolution so all the 

user has to do is tell it to start collecting data and it will stop sampling and open a dialog 



   

14 

window when it has collected enough data to obtain the resolution specified by the user. 

This resolution, combined with the lowest accelerometer resolution through a root of sum 

of squares calculation, results in an overall system resolution of 0.10000045 which we 

will round to 0.1. Thus, all results are presented out to the tenths digit. It can be seen that 

the system resolution is dominated by the resolution that is set in ModalVIEW so this 

value should be set to a resolution that is acceptable for the tests.  

 The shaker was activated so that the Super Hauler was excited with random 

excitation. ModalVIEW was then prompted to record data from the accelerometers and 

when ModalVIEW was done sampling the shaker was turned off. This was repeated so 

that two data sets were gathered at each loading and excitation configuration then the 

shaker was moved to the next excitation location and the process was rerun. 

 Once all of the vibration data was gathered, analysis was performed using 

ModalVIEW and followed the steps outlined below. First, ModalVIEW automatically 

generated FRFs from the data for each channel. A curve could then be fit to the FRF to 

find the modes by selecting a frequency range for ModalVIEW to analyze and the 

number of modes within that range. This can be seen in Figure 12. The ranges selected 

varied and depended on the curve. The ranges were chosen so that a good curve fit could 

be obtained. If there was a good curve fit the mode(s) would then be added to the mode 

list for that test.  
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Figure 12. Sample frequency response function with curve fit over the targeted mode. 

 

An example of using ModalVIEW to identify more than one mode within a range can 

seen in Figure 13. The FRFs were analyzed in this manner until a list of modes and 

natural frequencies was created for each test. Each FRF was analyzed to find the modes 

that lay within 0 Hz to 80 Hz. This range was chosen because the lower frequencies are 

the ones of interest but, since the operating frequency of the aircraft is unknown, the 

range needed to be large enough to capture all potential operating frequencies.  

 
Figure 13. Identifying multiple modes within a range in ModalVIEW. 

 

 ModalVIEW was then used to build a model of the Super Hauler. The 

accelerometers were assigned to their respective nodes and degrees of freedom. The 

structure could then be animated with the motion and mode shape associated with each 

natural frequency that was found. 
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CHAPTER III 

BASE MODEL

Test Description 

 The base model consisted of a planar model of the aircraft with 12 uni-axial 

accelerometers and 4 tri-axial accelerometers in the locations shown in Figure 14. All of 

the uni-axial accelerometers were mounted to measure acceleration in the Z direction 

except for the one on the vertical stabilizer, which was mounted to measure in the Y 

direction.  

 
Figure 14. Base model accelerometer locations (red = uni-axial, blue = tri-axial). 

 

 Proper sensor placement is a major topic in modal analysis. There is a balance to 

strike between having a limited number of sensors and placing sensors on most of the 

structure to capture all of the modes. Most sensor placement methods use complex 



   

17 

computer or mathematical modeling to identify important locations to place sensors. A 

discussion on several methods that have been developed for optimal sensor placement 

can be found in Chapter V. However, adequate sensor locations can be identified more 

simply through a knowledge of similar structures. This was the approach taken in placing 

the sensors for the base model. The placement locations were chosen based on a 

combination of an understanding of traditional aircraft motion and some preliminary 

testing that was performed. A literature review showed that the primary motion is 

bending and torsion in the wings with motion also occurring in the horizontal and vertical 

stabilizers and the fuselage [5, 11, 12]. Also, to identify torsion motion for use in flutter 

analysis, sensors needed to be placed on the front and back of the wings and horizontal 

stabilizer. The sensor locations decided upon for the base model are not optimized or 

ideal locations but provide an adequate base for the testing. 

 The test was performed both with and without pods. When the pods were installed 

four more uni-axial accelerometers were added to measure the motion of the pods. The 

pod accelerometer locations are shown in Figure 15 where the two on the side of the pod 

were mounted in the Y direction and the two on the bottom of the pod were mounted in 

the Z direction.  
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Figure 15. Pod accelerometer locations. 

 

 The shaker was used to excite the aircraft at the excitation locations shown in 

Figure 10 with two tests being performed at each of the four excitation locations and two 

loading conditions (pods and no pods). This gives a total of 16 tests in the base model 

configuration. The natural frequencies presented are the average of eight tests. These 

eight tests are comprised of two tests at each of the four excitation locations.  

Results 

 The first mode shape that was observed was mode 1 type bending in the wings. 

This mode corresponded to natural frequencies of 12.4 Hz without the pods installed and 

11.0 Hz when the pods were installed. A representation of this mode shape can be seen in 

Figure 16. 
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Figure 16. Mode shape corresponding to a frequency of 12.4 Hz without pods (left) and 

11.0 Hz with pods (right). 

 

 The second mode shape consisted of tail torsion while the wingtips bent in 

opposite directions of each other. This mode corresponded to natural frequencies of 17.3 

Hz without pods and 15.6 Hz with pods. A representation of this mode shape can be seen 

in Figure 17. 

  
Figure 17. Mode shape corresponding to a frequency of 17.3 Hz without pods (left) and 

15.6 Hz with pods (right). 

 

 The third mode shape showed wingtip, wing, tail, horizontal stabilizer, and 

vertical stabilizer torsion while the wingtips also bent. This mode corresponded to natural 

frequencies of 20.8 Hz without pods and 18.9 Hz with pods. A representation of this 

mode shape can be seen in Figure 18. 
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Figure 18. Mode shape corresponding to a frequency of 20.8 Hz without pods (left) and 

18.9 Hz with pods (right). 

 

 The fourth mode shape only appeared in the no pods configuration. This mode 

consisted of wing torsion while the horizontal stabilizer bent slightly. It corresponded to a 

natural frequency of 26.7 Hz. A representation of this mode shape can be seen in Figure 

19. 

 
Figure 19. Mode shape corresponding to a frequency of 26.7 Hz without pods. 

 

 The fifth mode shape showed wing torsion in the same direction. This mode 

corresponded to natural frequencies of 28.9 Hz without pods and 20.6 Hz with pods. A 

representation of this mode shape can be seen in Figure 20. 
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Figure 20. Mode shape corresponding to a frequency of 28.9 Hz without pods (left) and 

20.6 Hz with pods (right). 

 

 The sixth mode shape showed the wingtips bending in opposite directions of each 

other while the tail moved side to side and the horizontal stabilizer underwent torsion and 

bending. The horizontal stabilizer showed signs of flutter but all discussions of flutter 

will be reserved for Chapter VI. This mode corresponded to natural frequencies of 29.5 

Hz without pods and 23.2 Hz with pods. A representation of this mode shape can be seen 

in Figure 21. 

  
Figure 21. Mode shape corresponding to a frequency of 29.5 Hz without pods (left) and 

23.2 Hz with pods (right). 

 

 The seventh mode shape showed the wingtips bending in opposite directions of 

each other while the tail moved side to side. This mode corresponded to natural 

frequencies of 30.2 Hz without pods and 24.8 Hz with pods. A representation of this 

mode shape can be seen in Figure 22. 
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Figure 22. Mode shape corresponding to a frequency of 30.2 Hz without pods (left) and 

24.8 Hz with pods (right). 

 

 The eighth mode shape showed horizontal and vertical stabilizer torsion. This 

mode only appeared in the no pods configuration and corresponded to a natural frequency 

of 33.8 Hz. A representation of this mode shape can be seen in Figure 23. 

 

Figure 23. Mode shape corresponding to a frequency of 33.8 Hz without pods. 

 The ninth mode shape showed the horizontal stabilizer under bending and torsion 

with mode 2 bending in the wings and vertical stabilizer torsion. This mode was only 

visible in the no pod configuration and corresponded to a natural frequency of 39.9 Hz. A 

representation of this mode shape can be seen in Figure 24. 
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Figure 24. Mode shape corresponding to a frequency of 39.9 Hz without pods. 

 

 The tenth mode shape showed the wings experiencing mode 2 type bending with 

horizontal stabilizer bending and torsion. This mode corresponded to natural frequencies 

of 45.0 Hz without pods and 34.0 Hz with pods. A representation of this mode shape can 

be seen in Figure 25. 

  
Figure 25. Mode shape corresponding to a frequency of 45.0 Hz without pods (left) and 

34.0 Hz with pods (right). 

 

 The eleventh mode shape showed wing and horizontal stabilizer torsion in the 

same direction. This mode corresponded to natural frequencies of 51.4 Hz without pods 

and 38.3 Hz with pods. A representation of this mode shape can be seen in Figure 26. 
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Figure 26. Mode shape corresponding to a frequency of 51.4 Hz without pods (left) and 

38.3 Hz with pods (right).  

 

 The twelfth mode shape only appeared with the pods and showed the wings in 

torsion and the horizontal stabilizer in bending and torsion. This mode corresponded to a 

natural frequency of 40.9 Hz. A representation of this mode shape can be seen in Figure 

27. 

 
Figure 27. Mode shape corresponding to a frequency of 40.9 Hz with pods. 

 

 The thirteenth mode shape showed wing torsion in opposite directions from each 

other while the horizontal stabilizer and the fuselage both bent. This mode corresponded 

to natural frequencies of 63.7 Hz without pods and 47.4 Hz with pods. A representation 

of this mode shape can be seen in Figure 28. 
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Figure 28. Mode shape corresponding to a frequency of 63.7 Hz without pods (left) and 

47.4 Hz with pods (right). 

 

 The fourteenth mode shape only appeared without the pods and showed the wings 

undergoing mode 2 bending and torsion and the horizontal stabilizer in torsion. This 

mode corresponded to a natural frequency of 72.3 Hz. A representation of this mode 

shape can be seen in Figure 29. 

 
Figure 29. Mode shape corresponding to a frequency of 72.3 Hz without pods. 

 

 The fifteenth mode shape showed horizontal stabilizer torsion while the wings 

underwent mode 2 wing torsion. This mode corresponded to natural frequencies of 74.4 

Hz without pods and 53.6 Hz with pods. A representation of this mode shape can be seen 

in Figure 30. 
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Figure 30. Mode shape corresponding to a frequency of 74.4 Hz without pods (left) and 

53.6 Hz with pods (right). 

 

Discussion 

 The results are summarized in Table 2. It can be seen that the natural frequencies 

with the pods are approximately 10%-30% smaller than the corresponding natural 

frequencies without pods.  

Table 2. Summarized natural frequencies (Hz) and damping ratios (%) for the base model 

with and without pods and percent difference between natural frequencies. 

No Pods Pods Diff Description 

Freq Damp Freq Damp   

12.4 1.4 11.0 1.2 11.3 Mode 1 wing bending 

17.3 2.0 15.6 1.4 9.8 Tail torsion, antisymmetric wingtip bend 

20.8 2.0 18.9 2.3 9.1 Wingtip, wing, tail, HS, VS torsion, wingtip bend 

26.7 1.7 - - - Wing torsion, slight HS bend 

28.9 1.4 20.6 2.1 28.7 Symmetric wing torsion 

29.5 1.4 23.2 1.5 21.4 Wingtip bend, HS bend/torsion, tail wag 

30.2 1.0 24.8 1.9 17.9 Antisymmetric wingtip bend, tail wag 

33.8 0.7 - - - HS, VS torsion 

39.9 2.0 - - - HS bend/torsion, mode 2 wing bend, VS torsion 

45.0 1.8 34.0 1.8 24.4 Mode 2 wing bend, HS bend/torsion, VS torsion 

51.4 0.8 38.3 3.9 25.5 Wing torsion, HS bend/torsion 

- - 40.9 2.8 - Mode 2 wing torsion, HS bend/torsion 

63.7 1.2 47.4 2.8 25.6 Wing torsion, HS bend, fuselage bend 

72.3 1.2 - - - Mode 2 wing bend/torsion opposite, HS torsion 

74.4 1.7 53.6 1.9 28 HS torsion, mode 2 wing torsion 
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 The decrease in the natural frequencies was expected since, when installed, the 

wing pods account for 20% of the total weight of the aircraft. The addition of the wing 

pods creates a whole new structure that may not have all of the same modes as the 

structure with no pods. This behavior is apparent in several tests where modes only 

appeared in one or the other of the loading configurations (i.e. 26.7 Hz, 33.8 Hz, 39.9 Hz, 

and 72.3 Hz without pods and 40.9 Hz with pods). Different levels of instrumentation or 

different excitation locations can change the relative sizes of the FRFs. This can affect 

the ability to identify certain modes. It is difficult at times to differentiate between actual 

modes and noise in the channels. For these tests, peaks in the FRFs were determined to be 

significant and to be actual modes if they appeared in several tests across multiple 

excitation locations, and if those tests had a well defined mode shape. There is an 

inherent danger that modes could be missed in the analysis. This was seen in this testing 

when the mode at 72.3 Hz was not identified in the initial analysis of the data but was 

discovered later in re-analysis once it was found in other tests.  

Tests with Payload 

 Tests with and without the pods were also performed with a dummy payload 

weighing 15 pounds placed in the payload bay. A summary of the natural frequencies is 

presented in Table 3. 
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Table 3. Summary of natural frequencies for unloaded and loaded configurations. 

No Pods  Pods 

Unloaded Loaded %Diff  Unloaded Loaded %Diff 

12.4 12.0 3.2  11.0 11.0 - 

17.3 17.5 1.2  15.6 15.3 1.9 

20.8 20.9 0.5  18.9 18.8 0.5 

26.7 25.2 5.6  - - - 

28.9 27.4 5.2  20.6 20.7 0.5 

29.5 - -  23.2 23.0 0.9 

30.2 30.3 0.3  24.8 24.8 0.0 

33.8 32.7 3.3  - - - 

39.9 39.2 1.8  - - - 

45.0 45.2 0.4  34.0 33.3 2.1 

51.4 51.6 0.4  38.3 37.6 1.8 

- - -  40.9 40.4 1.2 

63.7 62.7 1.6  47.4 46.9 1.1 

72.3 - -  - - - 

74.4 74.8 0.5  53.6 54.5 1.7 

 

 As can be seen, the load in the payload bay, near the center of gravity, didn't have 

much effect on the values for the natural frequencies. Most of the loaded frequencies 

were within 3% of the corresponding unloaded frequencies with a maximum difference 

of 5.6%. This shows that a wing loading has much more of an effect on the structural 

characteristics of the aircraft than a fuselage loading.
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CHAPTER IV 

CHANNEL REDUCTION

Introduction 

 Channel reduction is an important topic in modal analysis. With every extraneous 

channel there are associated costs. These costs include an extra sensor as well as the time 

spent installing, indexing, and logging the sensor as well as processing and analyzing the 

data obtained from said sensor [13]. Because of this, it is important to use as few 

channels as possible while still keeping enough to identify the modes of the structure 

[14]. A key point in channel reduction is sensor location selection. A method was 

developed for sensor location selection and is presented in Chapter V. To examine the 

effects of channel reduction, several tests were performed with different types and levels 

of channel reduction. The first type of channel reduction that was tested was the use of a 

stick model rather than a planar model of the aircraft. The other type of channel reduction 

was the removal of different sensors. These are identified by WHV (accelerometers on 

the wings, horizontal stabilizer, and vertical stabilizer), WH (accelerometers on the wings 

and horizontal stabilizer), and W (accelerometers on the wings only). The results from 

these tests are presented in subsequent sections. 
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Stick Model 

Test Description 

 The first method of channel reduction performed was to use a simpler model of 

the aircraft. This model was just a stick model and it, along with the accelerometer 

locations for this test, can be seen in Figure 31. All uni-axial measurements were in the Z 

direction. 

 
Figure 31. Stick model and accelerometer locations (red = uni-axial, blue = tri-axial). 

 

The data obtained from the base model test, that excited the Super Hauler without pods 

with a random excitation, was reduced to these channels and the modal analysis was re-

run. 

Results 

 The first mode shape that was observed was mode 1 type bending in the wings. 

This mode corresponded to a natural frequency of 12.4 Hz and the base model's mode at 

12.4 Hz. A representation of this mode shape can be seen in Figure 32. 
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Figure 32. Mode shape corresponding to a frequency of 12.4 Hz for the stick model (left) 

and 12.4 Hz for the base model (right). 

 

 The second mode shape showed tail torsion while the wingtips bent in opposite 

directions of each other. This mode corresponded to a natural frequency of 17.5 Hz and 

the base model's mode at 17.3 Hz. A representation of this mode shape can be seen in 

Figure 33. 

 
Figure 33. Mode shape corresponding to a frequency of 17.5 Hz for the stick model (left) 

and 17.3 Hz for the base model (right). 

 

 The third mode shape showed wing and tail torsion while the wingtips bent. This 

mode corresponded to a natural frequency of 20.9 Hz and the base model's mode at 20.8 

Hz. A representation of this mode shape can be seen in Figure 34. 
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Figure 34. Mode shape corresponding to a frequency of 20.9 Hz for the stick model (left) 

and 20.8 Hz for the base model (right). 

 

 The fourth mode shape showed the wings bending while the horizontal stabilizer 

bent slightly. This mode corresponded to a natural frequency of 25.7 Hz and the base 

model's mode at 26.7 Hz. A representation of this mode shape can be seen in Figure 35. 

  
Figure 35. Mode shape corresponding to a frequency of 25.7 Hz for the stick model (left) 

and 26.7 Hz for the base model (right). 

 

 The fifth mode shape showed wing torsion in the same direction. This mode 

corresponded to a natural frequency of 27.4 Hz and the base model's mode at 28.9 Hz. A 

representation of this mode shape can be seen in Figure 36. 

  
Figure 36. Mode shape corresponding to a frequency of 27.4 Hz for the stick model (left) 

and 28.9 Hz for the base model (right). 
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 The sixth mode shape showed the wingtips bending in opposite directions of each 

other. This mode corresponded to a natural frequency of 31.0 Hz and the base model's 

mode at 30.2 Hz. A representation of this mode shape can be seen in Figure 37. 

  
Figure 37. Mode shape corresponding to a frequency of 31.0 Hz for the stick model (left) 

and 30.2 Hz for the base model (right). 

 

 The seventh mode shape showed the horizontal stabilizer bending. This mode 

corresponded to a natural frequency of 37.9 Hz and the base model's mode at 33.8 Hz. A 

representation of this mode shape can be seen in Figure 38. 

  

Figure 38. Mode shape corresponding to a frequency of 37.9 Hz for the stick model (left) 

and 33.8 Hz for the base model (right). 

 

 The eighth mode shape showed the horizontal stabilizer bending while the wings 

experienced mode 2 bending. This mode corresponded to a natural frequency of 39.9 Hz 

and the base model's mode at 39.9 Hz. A representation of this mode shape can be seen in 

Figure 39. 
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Figure 39. Mode shape corresponding to a frequency of 39.9 Hz for the stick model (left) 

and 39.9 Hz for the base model (right). 

 

 The ninth mode shape showed the wings experiencing mode 2 type bending while 

the horizontal stabilizer bent. This mode corresponded to a natural frequency of 44.9 Hz 

and the base model's mode at 45.0 Hz. A representation of this mode shape can be seen in 

Figure 40. 

  
Figure 40. Mode shape corresponding to a frequency of 44.9 Hz for the stick model (left) 

and 45.0 Hz for the base model (right). 

 

 The tenth mode shape showed the wings and the horizontal stabilizer bending. 

This mode corresponded to a natural frequency of 50.4 Hz and the base model's mode at 

51.4 Hz. A representation of this mode shape can be seen in Figure 41. 
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Figure 41. Mode shape corresponding to a frequency of 50.4 Hz for the stick model (left) 

and 51.4 Hz for the base model (right). 

 

 The eleventh mode shape showed wing torsion and the horizontal stabilizer 

bending. This mode corresponded to a natural frequency of 64.1 Hz and the base model's 

mode at 63.7 Hz. A representation of this mode shape can be seen in Figure 42. 

  
Figure 42. Mode shape corresponding to a frequency of 64.1 Hz for the stick model (left) 

and 63.7 Hz for the base model (right). 

 

 The twelfth mode shape showed the wings in mode 2 wing bending while the 

horizontal stabilizer bent. This mode corresponded to a natural frequency of 72.8 Hz and 

the base model's mode at 72.3 Hz. A representation of this mode shape can be seen in 

Figure 43. 
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Figure 43. Mode shape corresponding to a frequency of 72.8 Hz for the stick model (left) 

and 72.3 Hz for the base model (right). 

 

 The thirteenth mode shape showed the horizontal stabilizer bending while the 

wings underwent mode 2 wing bending. This mode corresponded to a natural frequency 

of 76.2 Hz and the base model's mode at 74.4 Hz. A representation of this mode shape 

can be seen in Figure 44. 

  
Figure 44. Mode shape corresponding to a frequency of 76.2 Hz for the stick model (left) 

and 74.4 Hz for the base model (right). 

 

Discussion/Comparison 

 A summary of the natural frequencies found in the stick model compared to the 

natural frequencies for the base model with no pods can be seen in Table 4.  
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Table 4. Stick model natural frequency summary. 

Stick 

Model 

Base 

Model %Diff Description 

12.4 12.4 0.0 Mode 1 wing bending 

17.5 17.3 1.2 Tail torsion, antisymmetric wingtip bend 

20.9 20.8 0.5 Wingtip, wing, tail, HS, VS torsion, wingtip bend 

25.7 26.7 3.7 Wing torsion, slight HS bend 

27.4 28.9 5.2 Symmetric wing torsion 

31.0 30.2 2.6 Wingtips bend opposite, tail wag 

37.9 33.8 12.1 HS, VS torsion 

39.9 39.9 0.0 HS bend/torsion, mode 2 wing bend, VS torsion 

44.9 45.0 0.2 Mode 2 wing bend, HS bend/torsion, VS torsion 

50.4 51.4 1.9 Wing torsion, HS bend/torsion 

64.1 63.7 0.6 Antisymmetric wing torsion, HS bend, fuselage bend 

72.8 72.3 0.7 Mode 2 wing bend/torsion opposite, HS torsion 

76.2 74.4 2.4 HS torsion, mode 2 wing bend and torsion 

 

The natural frequency values match fairly well with most values differing by less than 

2% with a maximum difference of 12%. As would make sense from the data that was 

removed, any torsional motion was undetectable using the stick model. This is a 

significant loss of data since the ability to detect torsional motion is a key factor in 

airworthiness determinations. 

Dangers of Channel Reduction 

Description 

 A preliminary test was performed before the base test where the excitation was 

provided through the use of an impact hammer at the locations and in the directions 

shown in Figure 45. The tests were performed both with and without the pods and the 

resulting modes were compared, demonstrating the further reduction of sensor locations. 
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Figure 45. Impact hammer excitation locations and directions. 

 

 The impact hammer that was used was a PCB Piezotronics 086C03 impact 

hammer and can be seen in Figure 46. The impact hammer interfaced with the data 

acquisition board that was used for the other tests.  

 
Figure 46. PCB Piezotronics 086C03 impact hammer used for excitation. 
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 The sampling rate was left at the default of 1651.61Hz with a resolution of 1Hz. 

The measurement type was FRF-OMA for an operation excitation modal analysis with 

number of nodes set to 11. The windowing type was set to rectangle with RMS averaging 

and exponential weighting with a count of 3. Each of the tests consisted of impacting the 

Super Hauler at one of the nodes and measuring the frequency response then obtaining 

the natural frequencies from the frequency response function (FRF) and animating the 

line model with the corresponding mode shapes. 

Results and Discussion 

 The results from this testing were published in a conference paper as shown in 

Table 5, and the corresponding mode shapes can be seen in the following figures [3]. 

However, these results were revisited after the base model test was run and it was 

discovered that, due to the lack of data in a stick model, several modes were originally 

misidentified in the preliminary test. 

Table 5. Summary of preliminary test natural frequencies. 

No Pods Pods Description 

12 - Wing-tip bending only 

27 11 Tail torsion only 

28 13 Wing bending opposite tail bending 

73 20 Wing bending and tail torsion 

91 28 Mode 2 wing bending 
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Figure 47. Mode shape corresponding to a frequency of 12 Hz without pods. 

 

 
Figure 48. Mode shapes corresponding to a frequency of 27 Hz without pods (left) and 11 

Hz with pods (right). 

 

 
Figure 49. Mode shapes corresponding to a frequency of 28 Hz without pods (left) and 13 

Hz with pods (right). 

 

 
Figure 50. Mode shapes corresponding to a frequency of 73 Hz without pods (left) and 20 

Hz with pods (right). 
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Figure 51. Mode shapes corresponding to a frequency of 91 Hz without pods (left) and 28 

Hz with pods (right). 

 

 Upon further inspection and comparison to the results from the base model tests 

and the random excitation stick model tests, the modes were re-identified as shown in 

Table 6.  

Table 6. Adjusted preliminary test mode identification. 

No Pods 

Prelim   Base 

Pods 

Prelim    Base Description 

12 12.4 - 11.0 Mode 1 wing bending 

- 17.3 11 15.6 Tail torsion, antisymmetric wingtip bend 

- - 13 - Wing, HS bending 

27 20.8 20 18.9 Wingtip, wing, tail, HS, VS torsion, wingtip bend 

- 26.7 - - Wing torsion, slight HS bend 

28 28.9 - 20.6 Symmetric wing torsion 

- 29.5 - 23.2 Antisymmetric wingtip bend, HS bend/torsion, tail wag 

- 30.2 - 24.8 Antisymmetric wingtip bend, tail wag 

- 33.8 - - HS, VS torsion 

- 39.9 - - HS bend/torsion, mode 2 wing bend, VS torsion 

- 45.0 28 34.0 Mode 2 wing bend, HS bend/torsion, VS torsion 

- 51.4 - 38.3 Wing torsion, HS bend/torsion 

- - - 40.9 Mode 2 wing bend and torsion 

- 63.7 - 47.4 Antisymmetric wing torsion, HS bend, fuselage bend 

73 72.3 - - Mode 2 wing bend/torsion opposite, HS torsion 

- 74.4 - 53.6 HS torsion, mode 2 wing bend and torsion 
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 It can be seen that, besides misidentifying modes, several modes were missed as 

well. It is believed that this is partly due to the analysis being performed on a much larger 

frequency range (0Hz ~ 300 Hz rather than 0Hz ~ 80 Hz), resulting in much lower 

resolution and a decreased ability to identify modes with smaller effects. 

WHV Model 

Test Description 

 The following channel reductions take a different approach than the stick model. 

The planar model is kept but data from various accelerometers are removed from the base 

model. For the WHV test, the data from the accelerometers along the fuselage of the 

aircraft, as well as the X and Y directional data from the tri-axial accelerometers and the 

data from uni-axial accelerometer on the vertical stabilizer were removed from the base 

model data set and the modal analysis was re-run. The remaining accelerometer locations 

can be seen in Figure 52 where all measurements were uni-axial and in the Z direction, 

except for the measurement on the vertical stabilizer which was in the Y direction. 

 
Figure 52. WHV accelerometer locations. 
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Results 

 The first mode shape that was observed was mode 1 type bending in the wings. 

This mode corresponded to a natural frequency of 12.4 Hz and the base model's mode at 

12.4 Hz. A representation of this mode shape can be seen in Figure 53. 

 
Figure 53. Mode shape corresponding to a frequency of 12.4 Hz for WHV (left) and 12.4 

Hz for the base model (right). 

 

 The second mode shape showed tail torsion while the wingtips bent in opposite 

directions of each other. This mode corresponded to a natural frequency of 17.5 Hz and 

the base model's mode at 17.3 Hz. A representation of this mode shape can be seen in 

Figure 54. 

 
Figure 54. Mode shape corresponding to a frequency of 17.5 Hz for WHV (left) and 17.3 

Hz for the base model (right). 
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 The third mode shape showed wingtip, wing, tail, horizontal stabilizer, and 

vertical stabilizer torsion while the wingtips also bent. This mode corresponded to a 

natural frequency of 20.8 Hz and the base model's mode at 20.8 Hz. A representation of 

this mode shape can be seen in Figure 55. 

 
Figure 55. Mode shape corresponding to a frequency of 20.8 Hz for WHV (left) and 20.8 

Hz for the base model (right). 

 

 The fourth mode shape showed wing torsion while the horizontal stabilizer bent 

slightly. This mode corresponded to a natural frequency of 26.0 Hz and the base model's 

mode at 26.7 Hz. A representation of this mode shape can be seen in Figure 56. 

 
Figure 56. Mode shape corresponding to a frequency of 26.0 Hz for WHV (left) and 26.7 

Hz for the base model (right). 

 

 The fifth mode shape showed wing torsion in the same direction. This mode 

corresponded to a natural frequency of 28.2 Hz and the base model's mode at 28.9 Hz. A 

representation of this mode shape can be seen in Figure 57. 
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Figure 57. Mode shape corresponding to a frequency of 28.2 Hz for WHV (left) and 28.9 

Hz for the base model (right). 

 

 The sixth mode shape showed the wingtips bending in opposite directions of each 

other. This mode corresponded to a natural frequency of 30.8 Hz and the base model's 

mode at 30.2 Hz. A representation of this mode shape can be seen in Figure 58. 

 
Figure 58. Mode shape corresponding to a frequency of 30.8 Hz for WHV (left) and 30.2 

Hz for the base model (right). 

 

 The seventh mode shape showed horizontal and vertical stabilizer torsion. This 

mode corresponded to a natural frequency of 36.5 Hz and the base model's mode at 33.8 

Hz. A representation of this mode shape can be seen in Figure 59. 

 

Figure 59. Mode shape corresponding to a frequency of 36.5 Hz for WHV (left) and 33.8 

Hz for the base model (right). 
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 The eighth mode shape showed horizontal stabilizer bending and torsion while the 

wings experienced mode 2 bending and the vertical stabilizer experienced torsion. This 

mode corresponded to a natural frequency of 39.7 Hz and the base model's mode at 39.9 

Hz. A representation of this mode shape can be seen in Figure 60. 

 
Figure 60. Mode shape corresponding to a frequency of 39.7 Hz for WHV (left) and 39.9 

Hz for the base model (right). 

 

 The ninth mode shape showed the wings experiencing mode 2 type bending with 

horizontal stabilizer bending and torsion. This mode corresponded to a natural frequency 

of 44.9 Hz and the base model's mode at 45.0 Hz. A representation of this mode shape 

can be seen in Figure 61. 

 
Figure 61. Mode shape corresponding to a frequency of 44.9 Hz for WHV (left) and 45.0 

Hz for the base model (right). 

 

 The tenth mode shape showed wing and horizontal stabilizer torsion in the same 

direction. This mode corresponded to a natural frequency of 51.0 Hz and the base model's 

mode at 51.4 Hz. A representation of this mode shape can be seen in Figure 62. 
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Figure 62. Mode shape corresponding to a frequency of 51.0 Hz for WHV (left) and 51.4 

Hz for the base model (right). 

 

 The eleventh mode shape showed wing torsion in opposite directions from each 

other while the horizontal stabilizer bent. This mode corresponded to a natural frequency 

of 61.1 Hz and the base model's mode at 63.7 Hz. A representation of this mode shape 

can be seen in Figure 63. 

 
Figure 63. Mode shape corresponding to a frequency of 61.1 Hz for WHV (left) and 63.7 

Hz for the base model (right). 

 

 The twelfth mode shape showed the wings undergoing mode 2 bending and 

torsion and the horizontal stabilizer in torsion. This mode corresponded to a natural 

frequency of 73.3 Hz and the base model's mode at 72.3 Hz. A representation of this 

mode shape can be seen in Figure 64. 
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Figure 64. Mode shape corresponding to a frequency of 73.3 Hz for WHV (left) and 72.3 

Hz for the base model (right). 

 

 The thirteenth mode shape showed horizontal stabilizer torsion while the wings 

underwent mode 2 wing bending and torsion. This mode corresponded to a natural 

frequency of 75.9 Hz and the base model's mode at 74.4 Hz. A representation of this 

mode shape can be seen in Figure 65. 

 
Figure 65. Mode shape corresponding to a frequency of 75.9 Hz for WHV (left) and 74.4 

Hz for the base model (right). 

 

Discussion/Comparison 

 A summary of the natural frequencies found in the WHV test, compared to the 

natural frequencies for the base model with no pods, can be seen in Table 7. The natural 

frequency values match fairly well with most values differing less than 2% with a 

maximum difference of 8%.  
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Table 7. WHV natural frequency summary. 

WHV Base Model %Diff Description 

12.4 12.4 0.0 Mode 1 wing bending 

17.5 17.3 1.2 Tail torsion, antisymmetric wingtip bend 

20.8 20.8 0.0 Wingtip, wing, tail, HS, VS torsion, wingtip bend 

26.0 26.7 2.6 Wing torsion, slight HS bend 

28.2 28.9 2.4 Symmetric wing torsion 

30.8 30.2 2.0 Antisymmetric wingtip bend, tail wag 

36.5 33.8 8.0 HS, VS torsion 

39.7 39.9 0.5 HS bend/torsion, mode 2 wing bend, VS torsion 

44.9 45.0 0.2 Mode 2 wing bend, HS bend/torsion, VS torsion 

51.0 51.4 0.8 Wing torsion, HS bend/torsion 

61.1 63.7 4.1 Antisymmetric wing torsion, HS bend, fuselage bend 

73.3 72.3 1.4 Mode 2 wing bend/torsion opposite, HS torsion 

75.9 74.4 2.0 HS torsion, mode 2 wing bend and torsion 

 

 It can be seen that the WHV test captured all of the natural frequencies that were 

observed in the base model. However, as would make sense from the data that was 

removed, any motion in the fuselage was undetectable using the WHV data. Since there 

was relatively little activity in the fuselage when compared to the rest of the structure, the 

inability to observe that motion is fairly insignificant. The motion in the fuselage is also 

not important in flutter analysis so it doesn't factor into airworthiness determinations. 

WH Model 

Test Description 

 The data was further parsed to remove the data from the remaining accelerometer 

on the vertical stabilizer and the modal analysis was re-run. The remaining  accelerometer 

locations can be seen in Figure 66 where all measurements were uni-axial and in the Z 

direction. 
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Figure 66. WH accelerometer locations. 

 

Results 

 The first mode shape that was observed was mode 1 type bending in the wings. 

This mode corresponded to a natural frequency of 12.4 Hz and the base model's mode at 

12.4 Hz. A representation of this mode shape can be seen in Figure 67. 

 
Figure 67. Mode shape corresponding to a frequency of 12.4 Hz for WH (left) and 12.4 

Hz for the base model (right). 
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 The second mode shape showed tail torsion while the wingtips bent in opposite 

directions of each other. This mode corresponded to a natural frequency of 17.5 Hz and 

the base model's mode at 17.3 Hz. A representation of this mode shape can be seen in 

Figure 68. 

 
Figure 68. Mode shape corresponding to a frequency of 17.5 Hz for WH (left) and 17.3 

Hz for the base model (right). 

 

 The third mode shape showed wingtip, wing, tail, and horizontal stabilizer torsion 

while the wingtips also bent. This mode corresponded to a natural frequency of 20.8 Hz 

and the base model's mode at 20.8 Hz. A representation of this mode shape can be seen in 

Figure 69. 

 
Figure 69. Mode shape corresponding to a frequency of 20.8 Hz for WH (left) and 20.8 

Hz for the base model (right). 
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 The fourth mode shape showed wing torsion while the horizontal stabilizer bent 

slightly. This mode corresponded to a natural frequency of 26.0 Hz and the base model's 

mode at 26.7 Hz. A representation of this mode shape can be seen in Figure 70. 

 
Figure 70. Mode shape corresponding to a frequency of 26.0 Hz for WH (left) and 26.7 

Hz for the base model (right). 

 

 The fifth mode shape showed wing torsion in the same direction. This mode 

corresponded to a natural frequency of 28.1 Hz and the base model's mode at 28.9 Hz. A 

representation of this mode shape can be seen in Figure 71. 

 
Figure 71. Mode shape corresponding to a frequency of 28.1 Hz for WH (left) and 28.9 

Hz for the base model (right). 

 

 The sixth mode shape showed the wingtips bending in opposite directions of each 

other. This mode corresponded to a natural frequency of 30.8 Hz and the base model's 

mode at 30.2 Hz. A representation of this mode shape can be seen in Figure 72. 
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Figure 72. Mode shape corresponding to a frequency of 30.8 Hz for WH (left) and 30.2 

Hz for the base model (right). 

 

 The seventh mode shape showed horizontal stabilizer torsion. This mode 

corresponded to a natural frequency of 36.1 Hz and the base model's mode at 33.8 Hz. A 

representation of this mode shape can be seen in Figure 73. 

 

Figure 73. Mode shape corresponding to a frequency of 36.1 Hz for WH (left) and 33.8 

Hz for the base model (right). 

 The eighth mode shape showed horizontal stabilizer bending and torsion while the 

wings experienced mode 2 bending. This mode corresponded to a natural frequency of 

39.8 Hz and the base model's mode at 39.9 Hz. A representation of this mode shape can 

be seen in Figure 74. 

 
Figure 74. Mode shape corresponding to a frequency of 39.8 Hz for WH (left) and 39.9 

Hz for the base model (right). 
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 The ninth mode shape showed the wings experiencing mode 2 type bending while 

the horizontal stabilizer experienced bending and torsion. This mode corresponded to a 

natural frequency of 44.9 Hz and the base model's mode at 45.0 Hz. A representation of 

this mode shape can be seen in Figure 75. 

 
Figure 75. Mode shape corresponding to a frequency of 44.9 Hz for WH (left) and 45.0 

Hz for the base model (right). 

 

 The tenth mode shape showed wing and the horizontal stabilizer torsion in the 

same direction. This mode corresponded to a natural frequency of 51.7 Hz and the base 

model's mode at 51.4 Hz. A representation of this mode shape can be seen in Figure 76. 

 
Figure 76. Mode shape corresponding to a frequency of 51.7 Hz for WH (left) and 51.4 

Hz for the base model (right). 

 

 The eleventh mode shape showed wing torsion in opposite directions from each 

other while the horizontal stabilizer bent. This mode corresponded to a natural frequency 

of 62.9 Hz and the base model's mode at 63.7 Hz. A representation of this mode shape 

can be seen in Figure 77. 
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Figure 77. Mode shape corresponding to a frequency of 62.9 Hz for WH (left) and 63.7 

Hz for the base model (right). 

 

 The twelfth mode shape showed the wings undergoing mode 2 bending and 

torsion and the horizontal stabilizer in torsion. This mode corresponded to a natural 

frequency of 72.0 Hz and the base model's mode at 72.3 Hz. A representation of this 

mode shape can be seen in Figure 78. 

  
Figure 78. Mode shape corresponding to a frequency of 72.0 Hz for WH (left) and 72.3 

Hz for the base model (right). 

 

 The thirteenth mode shape showed horizontal stabilizer torsion while the wings 

underwent mode 2 wing bending and torsion. This mode corresponded to a natural 

frequency of 75.9 Hz and the base model's mode at 74.4 Hz. A representation of this 

mode shape can be seen in Figure 79. 
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Figure 79. Mode shape corresponding to a frequency of 75.9 Hz for WH (left) and 74.4 

Hz for the base model (right). 

 

Discussion/Comparison 

 A summary of the natural frequencies found from the WH test, as well as the 

natural frequencies for the base model with no pods, can be seen in Table 8. The natural 

frequency values between these models match fairly well with most values differing less 

than 2% with a maximum difference of 7%.  

Table 8. WH natural frequency summary 

WH Base Model %Diff Description 

12.4 12.4 0.0 Mode 1 wing bending 

17.5 17.3 1.2 Tail torsion, antisymmetric wingtip bend 

20.8 20.8 0.0 Wingtip, wing, tail, HS, VS torsion, wingtip bend 

26.0 26.7 2.6 Wing torsion, slight HS bend 

28.1 28.9 2.8 Symmetric wing torsion 

30.8 30.2 2.0 Antisymmetric wingtip bend, tail wag 

36.1 33.8 6.8 HS, VS torsion 

39.8 39.9 0.3 HS bend/torsion, mode 2 wing bend, VS torsion 

44.9 45.0 0.2 Mode 2 wing bend, HS bend/torsion, VS torsion 

51.7 51.4 0.6 Wing torsion, HS bend/torsion 

62.9 63.7 1.3 Antisymmetric wing torsion, HS bend, fuselage bend 

72.0 72.3 0.4 Mode 2 wing bend/torsion opposite, HS torsion 

75.9 74.4 2.0 HS torsion same, mode 2 wing bend and torsion same 
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 The WH test captured all of the natural frequencies that were seen in the base 

model. However, any motion in the fuselage or vertical stabilizer was undetectable using 

the WH data. The inability to observe this motion could be acceptable since the fuselage 

and vertical stabilizer don't experience much motion and all of the modes were detected. 

However, if flutter is a concern in the vertical stabilizer, this level of channel reduction 

would not be acceptable since the motion in the vertical stabilizer would have to be 

known to make an airworthiness determination. Therefore, depending on the application, 

this loss of ability to observe vertical stabilizer motion could be significant. 

W Model 

Test Description 

 The data was further parsed to remove all the accelerometers except for those on 

the wings and the modal analysis was re-run. The accelerometer locations can be seen in 

Figure 80 where all measurements were uni-axial and in the Z direction. 

 
Figure 80. W accelerometer locations. 
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Results 

 The first mode shape that was observed was mode 1 type bending in the wings. 

This mode corresponded to a natural frequency of 12.4 Hz and the base model's mode at 

12.4 Hz. A representation of this mode shape can be seen in Figure 81. 

 
Figure 81. Mode shape corresponding to a frequency of 12.4 Hz for W (left) and 12.4 Hz 

for the base model (right). 

 

 The second mode shape showed tail torsion while the wingtips bent in opposite 

directions of each other. This mode corresponded to a natural frequency of 17.5 Hz and 

the base model's mode at 17.3 Hz. A representation of this mode shape can be seen in 

Figure 82. 

 
Figure 82. Mode shape corresponding to a frequency of 17.5 Hz for W (left) and 17.3 Hz 

for the base model (right). 
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 The third mode shape showed wingtip and wing torsion while the wingtips also 

bent. This mode corresponded to a natural frequency of 21.0 Hz and the base model's 

mode at 20.8 Hz. A representation of this mode shape can be seen in Figure 83. 

 
Figure 83. Mode shape corresponding to a frequency of 21.0 Hz for W (left) and 20.8 Hz 

for the base model (right). 

 

 The fourth mode shape showed wing torsion. This mode corresponded to a natural 

frequency of 25.9 Hz and the base model's mode at 26.7 Hz. A representation of this 

mode shape can be seen in Figure 84. 

 
Figure 84. Mode shape corresponding to a frequency of 25.9 Hz for W (left) and 26.7 Hz 

for the base model (right). 

 

 The fifth mode shape showed wing torsion in the same direction. This mode 

corresponded to a natural frequency of 28.1 Hz and the base model's mode at 28.9 Hz. A 

representation of this mode shape can be seen in Figure 85. 
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Figure 85. Mode shape corresponding to a frequency of 28.1 Hz for W (left) and 28.9 Hz 

for the base model (right). 

 The sixth mode shape showed the wingtips bending in opposite directions of each 

other. This mode corresponded to a natural frequency of 30.7 Hz and the base model's 

mode at 30.2 Hz. A representation of this mode shape can be seen in Figure 86. 

 
Figure 86. Mode shape corresponding to a frequency of 30.7 Hz for W (left) and 30.2 Hz 

for the base model (right). 

 

 The seventh mode shape showed the wings experiencing mode 2 bending. This 

mode corresponded to a natural frequency of 39.8 Hz and the base model's mode at 39.9 

Hz. A representation of this mode shape can be seen in Figure 87. 

 
Figure 87. Mode shape corresponding to a frequency of 39.8 Hz for W (left) and 39.9 Hz 

for the base model (right). 
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 The eighth mode shape showed the wings experiencing mode 2 type bending. 

This mode corresponded to a natural frequency of 44.7 Hz and the base model's mode at 

45.0 Hz. A representation of this mode shape can be seen in Figure 88. 

 
Figure 88. Mode shape corresponding to a frequency of 44.7 Hz for W (left) and 45.0 Hz 

for the base model (right). 

 

 The ninth mode shape showed wing torsion in the same direction. This mode 

corresponded to a natural frequency of 50.6 Hz and the base model's mode at 51.4 Hz. A 

representation of this mode shape can be seen in Figure 89. 

 
Figure 89. Mode shape corresponding to a frequency of 50.6 Hz for W (left) and 51.4 Hz 

for the base model (right). 

 

 The tenth mode shape showed wing torsion in opposite directions from each 

other. This mode corresponded to a natural frequency of 64.1 Hz and the base model's 

mode at 63.7 Hz. A representation of this mode shape can be seen in Figure 90. 
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Figure 90. Mode shape corresponding to a frequency of 64.1 Hz for W (left) and 63.7 Hz 

for the base model (right). 

 

 The eleventh mode shape showed the wings undergoing mode 2 bending and 

torsion. This mode corresponded to a natural frequency of 71.9 Hz and the base model's 

mode at 72.3 Hz. A representation of this mode shape can be seen in Figure 91. 

  
Figure 91. Mode shape corresponding to a frequency of 71.9 Hz for W (left) and 72.3 Hz 

for the base model (right). 

 

 The twelfth mode shape showed the wings in mode 2 wing bending and torsion. 

This mode corresponded to a natural frequency of 75.8 Hz and the base model's mode at 

74.4 Hz. A representation of this mode shape can be seen in Figure 92. 

 
Figure 92. Mode shape corresponding to a frequency of 75.8 Hz for W (left) and 74.4 Hz 

for the base model (right). 
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Discussion/Comparison 

 A summary of the natural frequencies found in W, as well as the natural 

frequencies for the base model with no pods, can be seen in Table 9. The natural 

frequency values between these models match fairly well with most values differing less 

than 2% with a maximum difference of 3%.  

Table 9. W natural frequency summary. 

W Base Model %Diff Description 

12.4 12.4 0.0 Mode 1 wing bending 

17.5 17.3 1.2 Tail torsion, antisymmetric wingtip bend 

21.0 20.8 1.0 Wingtip, wing, tail, HS, VS torsion, wingtip bend 

25.9 26.7 3.0 Wing torsion, slight HS bend 

28.1 28.9 2.8 Symmetric wing torsion 

30.7 30.2 1.7 Antisymmetric wingtip bend, tail wag 

- 33.8 - HS, VS torsion 

39.8 39.9 0.3 HS bend/torsion, mode 2 wing bend, VS torsion 

44.7 45.0 0.7 Mode 2 wing bend, HS bend/torsion, VS torsion 

50.6 51.4 1.6 Wing torsion, HS bend/torsion 

64.1 63.7 0.6 Antisymmetric wing torsion, HS bend, fuselage bend 

71.9 72.3 0.6 Mode 2 wing bend/torsion opposite, HS torsion 

75.8 74.4 1.9 HS torsion, mode 2 wing bend and torsion 

 

 The W test captured almost all of the natural frequencies that were seen in the 

base model, missing one mode at 33.8 Hz. However, any motion in the fuselage or tail 

was undetectable in this test. The inability to detect a mode at 33.8 Hz can be traced to 

this fact since that mode consists of horizontal and vertical stabilizer motion. This factors 

into airworthiness determinations because of the inability to see motion in the horizontal 

stabilizer. This lack of important information leads to the conclusion that this is too much 

channel reduction and that the important surfaces of the aircraft should be instrumented.
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CHAPTER V 

SENSOR LOCATION IDENTIFICATION METHOD

Introduction 

 As stated previously, channel reduction is an important topic in modal testing and 

proper sensor location identification is key to using as few channels as possible. Several 

methods for identifying important locations for sensors have been developed. 

 One methodology uses a finite element model in which sensor sets are found 

which maximize the ability to observe modes while constraining each sensor to 

contribute unique information [15]. Another method selects sensor locations that make 

the corresponding target mode shape partitions as linearly independent as possible while 

maximizing the signal strength of the target modal responses within the sensor data [16]. 

Yet another method uses a genetic algorithm to identify sensor locations by starting with 

a relatively small number of possible final locations and evolving these locations to the 

best set [17]. There is also a method that locates sensors at the maximum response 

position of an orthogonal sequence of vectors [18]. 

 There are several more methods for sensor location identification but the majority 

of them require extensive finite element modeling, algorithm development, or 

mathematical modeling or a combination thereof. It was desired to develop a relatively 

quick and easy, non-contact, experimental method with which to identify important 
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sensor locations for complex systems that are difficult and time consuming to model. 

This was achieved through the use of a laser vibrometer. A laser vibrometer is a suitable 

tool to use for this purpose because of its mobility and its capability to gather vibration 

data in a non-contact manner. Laser vibrometers measure surface motion using the 

Doppler shift concept to measure the velocity of surface vibration [19]. Multi-point laser 

vibrometers have been used for several years for modal analysis but they have not been 

used for identifying important sensor locations. A test was performed in which a single 

beam laser vibrometer was used to measure the velocity of the surface of the aircraft at 

several locations. These values were then used to identify locations of high interaction. 

Test Description 

 The laser vibrometer that was used for the tests was a Polytech OFV 2601 Laser 

Vibrometer Controller with a Polytech CLV Laser Unit and a Polytech CLV 700 Laser 

Head. To perform the laser vibrometer testing, the Super Hauler was placed in the test 

rig and the shaker was attached in the location marked by the blue dot in Figure 94. The 

Super Hauler was in the no pods and unloaded condition.  
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Figure 93. Laser vibrometer testing setup. 

 

The laser vibrometer was mounted on a stand and directed to measure the vibration of the 

aircraft at the locations shown in Figure 94. All measurements were in the Z direction 

except for the two on the vertical stabilizer which were in the Y direction. 
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Figure 94. Excitation (blue) and measurement (red) locations for laser vibrometer tests. 

 

 The first step in the test procedure was to move the laser vibrometer to a 

measurement location and focus the laser to get a strong, clear signal. Next, the shaker 

was activated to vibrate the aircraft with random excitation. LabVIEW Signal Express 

was used to record the data from the vibrometer over a ten second period and export it to 

an Excel worksheet. These steps were repeated until three sets of data were gathered from 

each measurement location. 

Results 

 A sample of the data gathered is shown in Figure 95. The graph shows the voltage 

measurements taken by the laser vibrometer of a test location versus time with the 

voltage corresponding to amplitude. As can be seen, the data wasn't centered around zero 

and there were some outliers due to noise in the laser vibrometer. 
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Figure 95. Sample data from the laser vibrometer. 

 

Post processing was manually performed in Microsoft Excel to remove the outliers and 

then shift the data sets so that they had an average of zero. This was accomplished by 

manually deleting the outliers and then subtracting the average voltage from each value. 

An example of a data set before and after post processing can be seen in Figure 96.  
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(a) 

 
(b) 

Figure 96. (a) Raw laser vibrometer data. (b) Data with outliers removed and adjusted for 

an average of zero. 
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Figure 97. A zoomed in graph of Figure 96 (b). 

 

 To find an effective measure of the magnitude of vibration at each location, 

Equation (3) was used to calculate the Root Mean Square (RMS) value for each data set. 

                         (3) 

A representative RMS value for each measurement location was then found by 

calculating the average of the three RMS values from the three data sets at each location. 

The average RMS values can be seen in Figure 98.  
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Figure 98. Average RMS values for laser vibrometer measurement locations with 95% 

confidence intervals. 

 

This chart was created using Minitab with 95% confidence intervals. It can be seen that 

the nodes are distinctly different and the relatively small size of the error bars show that 

the tests were repeatable. 

Statistical Method 

 Once the average RMS values were calculated, it was desirable to establish a 

statistical method to select the important modes at which accelerometers need to be 

placed. The method that was selected was a Pareto diagram. 

 Pareto diagrams were introduced in the field of quality control and are used to 

determine the most significant aspects of a body of information [20]. Resources can then 

be used on the important aspects and not wasted on trivial aspects. The general rule on 

which the Pareto principle is based is that 20% of the defects cause 80% of the problems. 
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 The Pareto diagram method was applied to this test by first assuming all of the 

motion of the aircraft was captured by the measured locations. The average RMS values 

were then ordered from largest to smallest and the individual percentages of the total 

were calculated. These percentages were then summed to find a running cumulative 

percentage of the total aircraft motion captured. These results were then graphed and are 

shown in Figure 99. The average RMS values for each locations are shown in Table 10. 

A thorough screening of potential sensor locations must be conducted to help ensure that 

all the motion of interest is captured. The use of a laser vibrometer makes this process 

effective due to the efficiency of collecting data. 

 This diagram and table can be used to determine which locations should be 

measured. To capture 75% of the measured motion, nodes 5, 6, and 7, which are the 

nodes on the wings, should be instrumented. This corresponds to the W test. 

Alternatively, to capture 90% of the measured motion of the aircraft, nodes 8 and 9 

would have to be instrumented as well. Nodes 8 and 9 are on the horizontal stabilizer so 

this level of instrumentation would correspond to the WH test. To capture even more 

motion, nodes 10 and 11 could be instrumented as well to bring the measured motion up 

to 95%. These nodes are on the vertical stabilizer so their addition would almost 

correspond to the WHV test, (node 11 wasn't included in WHV). 
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Figure 99. Pareto diagram for laser vibrometer test. 

 

Table 10. Data used to create the Pareto diagram. 

Location Avg RMS % of Total Cum % 

Node 7 0.1382 42 42 

Node 6 0.0640 19 61 

Node 5 0.0412 13 74 

Node 8 0.0239 7 81 

Node 9 0.0201 6 87 

Node 10 0.0120 4 91 

Node 11 0.0080 2 93 

Node 4 0.0065 2 95 

Node 1 0.0057 2 97 

Node 2 0.0053 2 99 

Node 3 0.0046 1 100 

Total 0.3294   

 

A summary of the results from each of the tests, from the base test to the W test, are 

presented in Table 11.  
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Table 11. Summary of natural frequencies. 

Base WHV WH W Description 

12.4 12.4 12.4 12.4 Mode 1 wing bending 

17.3 17.5 17.5 17.5 Tail torsion, antisymmetric wingtip bend 

20.8 20.8 20.8 21.0 Wingtip, wing, tail, HS, VS torsion, wingtip bend 

26.7 26.0 26.0 25.9 Wing torsion, slight HS bend 

28.9 28.2 28.1 28.1 Symmetric wing torsion 

30.2 30.8 30.8 30.7 Antisymmetric wingtip bend, tail wag 

33.8 36.5 36.1 - HS, VS torsion 

39.9 39.7 39.8 39.8 HS bend/torsion, mode 2 wing bend, VS torsion 

45.0 44.9 44.9 44.7 Mode 2 wing bend, HS bend/torsion, VS torsion 

51.4 51.0 51.7 50.6 Wing torsion, HS bend/torsion 

63.7 61.1 62.9 64.1 Antisymmetric wing torsion, HS bend, fuselage bend 

72.3 73.3 72.0 71.9 Mode 2 wing bend/torsion opposite, HS torsion 

74.4 75.9 75.9 75.8 HS torsion, mode 2 wing bend and torsion 

 

 It can be seen that, according to this test, 90% of the motion should be captured 

by sensors if all of the modes are to be recognized. The values chosen in this case were 

chosen because they coincide with the various surfaces of the aircraft. The WHV test 

corresponded to 95% of the measured motion being captured by sensors and consisted of 

the wings, horizontal stabilizer, and vertical stabilizer being instrumented. The WH test 

corresponded to 90% and sensors on the wings and horizontal stabilizer and the W test 

corresponded to 75% and the wings. Since the correct level is case dependent, this value 

should be left to user discretion. 

 It is recommended that, when using this method, the response is measured at grid 

points over the entire structure. However, this method is very sensitive to grid size since 

it can't distinguish if it is repeatedly capturing the same mode and so, if the grid is too 

fine, could identify multiple points as significant that all correspond to the same response. 
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Therefore, good candidate measurement locations are critical in using this method. The 

grid needs to be fine enough that all of the modes of interest (i.e. bending, torsion) are 

captured but not so fine that the same behavior is captured by several locations. A good 

candidate grid can be established from the structural response of similar structures, finite 

element results, or previous experience. However, additional points to those that are 

deemed potentially significant should be included as there could be unexpected 

participating modes. This method can help capture these unexpected modes that occur 

due to complex structural interactions or complex structural response. 
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CHAPTER VI 

DETERMINATION OF AIRWORTHINESS

Flutter Overview 

 One of the main reasons that a ground vibration test on the Super Hauler was 

conducted was to determine if the aircraft was still airworthy after the addition of wing 

pods. A major concern in aircraft is aeroelastic flutter. Aeroelastic flutter is defined as 

involving the interaction of aerodynamic, elastic, and inertial forces on structures that 

produces an unstable oscillation that often results in structural failure [21]. Flutter is 

typically observed on surfaces, such as wings and tails, that encounter large aerodynamic 

loads [22].  

 Flutter occurs when the aerodynamic forces associated with motion in two modes 

of vibration (i.e. wing bending/torsion) cause the modes to couple adversely [23]. An 

uncontrolled increase in vibration amplitude is observed when the aircraft is moving fast 

enough that the structural damping is insufficient to quell the motion coming from 

aerodynamic energy being added to the surface [24]. Because of this, flutter can be 

disastrous when it occurs on an aircraft; even causing the wings to vibrate in increasing 

amplitude until they fall off of the aircraft. 

 Flutter is a complex field and much work has been done on developing methods 

and tests to identify and predict flutter. These tests include both ground vibration tests 
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and flight tests that include structural excitation, response measurement, and data analysis 

for stability [21]. Many flutter identification methods have been developed and a few are 

discussed below. 

 The most commonly used method is damping extrapolation [25]. This method is 

based on flight data and consists of extrapolating trends of modal damping [21]. When 

flutter starts, the damping of at least one mode goes to zero so this method notes the 

variation in the modal damping values with airspeed and extrapolates the values to find a 

critical airspeed where damping is zero. 

 The envelope function method predicts flutter using the time-domain 

measurements from sensors that measure the response to an impulse excitation [26]. This 

method states that the envelope bounding an impulse response increases as damping 

decreases. So a loss of damping, and thus the start of flutter, is indicated by the size and 

shape of the response envelope. A time centroid is also needed to establish stability since 

the amplitude of the envelope can be affected by the size and shape of the impulse. The 

final step in this method is to predict the flutter using a shape parameter which is the 

inverse of the time centroid and is assumed to be a polynomial function of airspeed. The 

flutter speed can then be calculated from the shape parameter. 

 The Zimmerman-Weissenburger margin method states that the flutter margin is an 

indicator of distance to flutter in terms of dynamic pressure [27]. This method was 

developed using the equations of motion for a classical aeroelastic system with bending 

and torsion modes. The method uses the characteristic polynomial that describes the 
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continuous-time aeroelastic system. The stability of the system is then established using 

the Routh stability criterion to find a parameter that is positive if the corresponding 

system is stable. The onset of flutter is then calculated by noting that the parameter that 

was found varies with dynamic pressure, thus the dynamic pressure at which flutter starts 

can be calculated from this parameter. 

 A flutterometer is a tool that can be used to predict flutter speeds using both 

theoretical models and FRFs [28]. This approach is based on μ-method analysis which 

computes a stability measure that is robust with respect to an uncertainty description. The 

largest increase in airspeed where the theoretical model remains stable with respect to the 

uncertainty is then the flutter speed. [29][30][31][32][33][34][35] 

 New aircraft are investigated for flutter from the early stages of design and are 

tested for flutter with GVTs and flight flutter tests [29-35]. GVTs are used to find the 

structural properties of an aircraft which are then used to validate the quality of an 

analytical model and its flutter predictions. The natural frequencies, damping ratios, and 

mode shapes found from the GVT are used to determine the error and uncertainty in the 

analytical model and are necessary in determining aeroelastic characteristics such as 

flutter [36, 5]. The results can also be used in wind tunnel tests or flight flutter tests [37, 

38]. These tests are performed to determine the flight envelope of an aircraft, including 

the flight flutter speed and frequency. 

 The results from the GVTs were used in a preliminary flutter study. A full flutter 

study was not performed on the Super Hauler but the results from the GVTs could be 
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used for further flutter tests such as flight tests or wind tunnel tests. The Super Hauler has 

been flown for several missions without the wing pods so the stability of the aircraft 

without wing pods had been established. The tests were performed to see if the addition 

of the wing pods changed the modes of the aircraft to the extent that flutter would be 

introduced in normal flight operations. Since the aircraft was well established as stable 

without the wing pods, the results from the tests were examined to see if the addition of 

the wing pods shifted the frequencies of the bending and torsion modes so that they were 

coincident. 

Flutter Results 

 The primary location on an aircraft where flutter is a concern is the wings. Table 

12 summarizes the modes that were dominated by wing motion and it can be seen that 

none of the frequencies aligned so that there were coupled torsion and bending modes. 

For instance, without pods, mode 1 wing bending was observed at 12.4 Hz with a wing 

torsional mode at 28.9 Hz. The addition of the pods moved both of those frequencies to 

11.0 Hz and 20.6 Hz, respectively, but they still remain two distinct modes. There is still 

a possibility that flutter could occur at a critical airspeed, but that behavior could only be 

established by further testing, including a flight flutter test or a wind tunnel test. 
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Table 12. Summary of wing modes. 

No Pods Pods Description 

12.4 11.0 Mode 1 wing bending 

28.9 20.6 Symmetric wing torsion 

29.5 23.2 Antisymmetric wingtip bend, HS bend/torsion, tail wag 

30.2 24.8 Antisymmetric wingtip bend, tail wag 

45.0 34.0 Mode 2 wing bend, HS bend/torsion, VS torsion 

51.4 38.3 Wing torsion, HS bend/torsion 

63.7 47.4 Antisymmetric wing torsion, HS bend, fuselage bend 

 

 The modes that were observed to contain potential for flutter with a combination 

of bending and torsional modes were noticed in the horizontal stabilizer and are 

summarized in Table 13. It can be seen that these modes appeared in the no pods 

configuration as well as with pods. This leads to the conclusion that the structural 

damping within the horizontal stabilizer is sufficient to overcome the flight loadings. As 

flight loadings are smaller on the horizontal stabilizer, flutter is not as significant of a 

problem on this surface.  

Table 13. Summary of potential horizontal stabilizer flutter modes. 

No Pods Pods Description 

29.5 23.2 Antisymmetric wingtip bend, HS bend/torsion, tail wag 

39.9 - HS bend/torsion, mode 2 wing bend, VS torsion 

45.0 34.0 Mode 2 wing bend, HS bend/torsion, VS torsion 

- 40.9 Mode 2 wing torsion, HS bend/torsion 

 

Flight Test 

 The Super Hauler was flown in July 2012 with the wing pods attached. Dummy 

weights were placed in the pods to simulate a payload. The weights added brought the 
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total weight of the pods to 5 lbs each. An image that was taken during the flight in which 

the pods are visible is shown in Figure 100. The flight was successful with no problems 

during flight and there was no noticeable change in the flight characteristics or handling 

of the aircraft. 

 
Figure 100. The Super Hauler in flight with the wing pods installed. 

 

 The preliminary flutter tests showed that the addition of the wing pods didn't 

introduce behavior that is a significant cause for concern. This was proven by a 

successful flight test. However, the discovery of some flutter characteristics in the 

horizontal stabilizer will lead to the UASE lab increasing the tension in the stabilizer 

wires on the Super Hauler. This will change the frequency response in the horizontal 

stabilizer and help reduce potential flutter tendencies. 
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CHAPTER VII 

CONCLUSION

 A full modal analysis investigating the effect of wing pods on a small UAS was 

presented. The pods were shown to lower the natural frequencies for corresponding mode 

shapes due to the mass added to the structure. An airworthiness investigation was 

performed and it was discovered that no wing flutter was introduced into the system with 

the addition of the pods. This leads to the conclusion that the wing pods are a safe 

addition to the aircraft and was demonstrated by a successful flight test of the UAS with 

the wing pods installed. No flutter behavior was observed and no change was noticed in 

how the aircraft handles. 

 A study was done on channel reduction and five tests with different levels and 

types of channel reduction were performed and analyzed. The stick model was found to 

be a poor option for channel reduction as torsional motion was undetectable and mode 

identification was very difficult. It was seen that it is better to simplify the model by 

keeping a more complex model and removing accelerometers from different surfaces. 

Three tests reducing channels in this manner were performed. From these tests it was 

found that the sensors along the fuselage of the aircraft and on the vertical stabilizer are 

unnecessary for this testing since all of the modes were still identifiable and knowledge 

of the motion in these surfaces was unnecessary for airworthiness determinations. The 
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sensors on the wings and horizontal stabilizer were found to be necessary. This 

conclusion was reached because of the loss of ability to identify a mode involving only 

horizontal and vertical stabilizer motion when only the wings were instrumented. Using 

these findings, the number of channels used in this test could be reduced from 24 

channels down to 10 channels. This reduction not only saves money by using less sensors 

and supporting equipment, but also saves time that would have been spent on data 

collection and analysis on the 14 extra channels. 

 A novel sensor location identification method was presented. This method was 

shown to provide a quick, relatively simple, non-contact, and experimental way to 

determine important sensor locations through the use of a laser vibrometer. The 

recommended testing procedure to follow when using the sensor location identification 

method is outlined below.  

 Set up the structure in a test rig so that it has free-free boundary conditions 

 Install a shaker at an location where all of the modes of the structure are excited 

 Decide upon and lay out an appropriate grid pattern at which to take 

measurements with the laser vibrometer 

 Take measurements at the grid points using the laser vibrometer  

 Process the output data to remove noise and any DC offset in the data 

 Calculate the RMS values 

 Construct a Pareto diagram to see the strongest contributing locations from the 

measured values 
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 Decide upon an appropriate Pareto level 

 Instrument the structure with accelerometers at the significant locations 

 Perform modal analysis 

 Extract natural frequencies and modal shapes from the FRFs 

 Analyze the results 

This development could be of interest to the vibration community as there hasn't been 

any evidence found of a similar method. The laser vibrometer was used to measure the 

response at several locations along the aircraft and the RMS values were calculated. A 

Pareto diagram was used to identify which of these locations are important to instrument 

by identifying which locations contribute to most of the motion experienced by the 

aircraft. This method would be most effectively used by measuring the motion at several 

locations on the structure and placing sensors at the nodes that capture a certain 

percentage of the motion that was measured. This provides the user with the flexibility to 

choose the percentage of motion that is important for that structure. 
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Appendix A

ModalVIEW Tutorial 

 This tutorial will highlight the steps required to set up and perform a basic modal 

analysis in ModalVIEW. The tutorial is split up into General Overview, Drawing 3D 

Structure Model, Performing Measurement, Experimental or Operational Modal 

Analysis, and Modal Shape Animation. 

General Overview 

 The main window that is seen when first starting ModalVIEW is shown in Figure 

101. 

 
Figure 101. Main window for ModalVIEW. 
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 The first step is to save the project by clicking File > Project > Save As. The links 

to navigate to the different operations in ModalVIEW can be seen under the Quick Start 

menu. The first one that will be detailed is Drawing 3D Structure Model. 

Drawing 3D Structure Model 

 The window seen when Drawing 3D Structure Model is selected can be seen in 

Figure 102. 

 
Figure 102. 3D Structure Model window. 

 

 To draw a structure, points first need to be placed. A point needs to be at any 

location that a sensor is going to be placed but more points can be placed at non-

instrumented locations to assist in the accurate build of the model. For this tutorial, a 

simple 5 x 10 plate will be constructed with sensors placed at three corners and in the 

middle. 
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 Points are placed by first selecting the  (Add Object) button in the Structure 

Editor Window while making sure the drop down list next to the button is set to Points. 

Click in the Structure 3D View window in the general locations that the points should be 

located. Click the Add Object button again to deselect the option. This can be seen in 

Figure 103. 

 
Figure 103. Initial point placement in Structure 3D View window. 

 

 The coordinates of each point can now be set by selecting the point and entering 

the point coordinates in the spots provided in the Structure Editor Window. The DOF of 

each point should also be assigned. An example of this can be seen in Figure 104. 
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Figure 104. Setting coordinates for the points in the structure. 

 

 To zoom in or out on the structure, click on the magnifying glass in the Structure 

3D View window and click and drag the mouse in the window. The next step is to add 

lines to the structure. To do this, select Lines needs from the drop down list and then 

click the Add Object button. To create a line between two points, click on each point and 

a line will be created. 

 
Figure 105. Adding lines to the structure. 
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 Continue doing this until all of the lines are created. Once the structure is 

complete, save the structure by clicking File > Save As and enter the desired file name. 

The completed plate can be seen in Figure 106. 

 
Figure 106. Completed structure. 

 

Performing Measurement 

 The next step in the modal analysis process is to measure the response. First, the 

structure needs to be fully instrumented with the DAQ connected to the computer that is 

equipped with ModalVIEW. The Performing Measurement link can then be clicked and 

the window shown in Figure 107 will come up. 
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Figure 107. Performing Measurement window. 

 

 The front end, or the DAQ, needs to be selected from the drop down list in the 

upper left hand corner (shown in Figure 108). The settings for the measurements can then 

be selected. 

 
Figure 108. Selecting the DAQ. 

 

 To pull up the DAQ Setup menu, click on the  button. The following window 

will open. 
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Figure 109. DAQ Setup window. 

 

 Under the Channel tab, turn off the channels that will not be used by clicking on 

the On in the Status column that corresponds to the unused channel and select Off. The 

options in the Acquisition tab can be seen in Figure 110. 
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Figure 110. DAQ Setup window, Acquisition tab. 

 

 The sampling rate should be left at the default as it is specific to the DAQ and is 

automatically recognized by ModalVIEW, but the resolution can be adjusted by changing 

the Block Size. It is recommended to increase the resolution from the default of about 1 

Hz to a resolution closer to 0.1 Hz. These settings can be applied by clicking Apply then 

OK. 

 To pull up the Test Setup menu, click on the  button. The following window 

will open. 
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Figure 111. Test Setup window. 

 

 In the Measurements tab, set the measurement type to FRF-EMA for experimental 

modal analysis by selecting FRF-EMA in the Type drop down menu. Adjust the number 

of nodes to the number that will be instrumented. The options in the Post-Process tab can 

be seen in Figure 112. 
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Figure 112. Test Setup window, Post-process tab. 

 

 The windowing type can be changed to the desired windowing in the type drop 

down menu. The options in the Measurement Sets tab can be seen in Figure 113. 
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Figure 113. Test Setup window, Measurement Sets tab. 

 

 The channels are automatically generated when the Generate button is clicked. 

This can be seen in Figure 114. 
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Figure 114. Channels generated in the Measurement Sets tab. 

 

 The appropriate DOF and direction which each channel measures can be set by 

clicking on the corresponding value in the DOF column and adjusting the value 

accordingly. An example of this can be seen in Figure 115. 
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Figure 115. Appropriate DOFs selected in Measurement Sets tab. 

 

 Apply the settings  by clicking Apply then OK. To save the configuration for later 

use, click File > Save Config As. 

 To pull up the Signal Generator menu, click on the  button. The following 

window will open. 
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Figure 116. Signal Generator Excitation window. 

 

 Select the appropriate DAQ in the Front End drop down menu then check the 

Enable box to enable excitation. Select either Random Noise or Swept Sine excitation in 

the Source drop down menu. The signal options (such as amplitude and period) can be set 

in the Signal tab which can be seen in Figure 117. 
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Figure 117. Signal options in Excitation window. 

 

 To start or stop the excitation click the  button in the Excitation window. To 

start taking measurements click the  button in the Measurement window. The 

program will collect measurements for the amount of time necessary for the assigned 

resolution and, when finished, will open a dialog window asking "Do you want to keep 

measurement". If the measurement looks good, click OK. Save the measurement by 

clicking File > Save Measurement. Delete the data from the spreadsheet when asked and 

repeat steps to collect another measurement. 
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Experimental or Operational Modal Analysis 

 The next step in the modal analysis process is to perform the actual modal 

analysis. To do so, click the Experimental or Operational Modal Analysis link in the main 

window. The following window will open. 

 
Figure 118. Experimental or Operational Modal Analysis window. 

 

 Select the measurement set to analyze by clicking File > Load. To change the axis 

from a log scale, right click on the axis and uncheck the log option. Zoom in on an area 

of interest by clicking on the + magnifying glass and selecting the area of interest. Click 

the Band Cursor button  to display bounds. This can be seen in Figure 119. 
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Figure 119. Measurement bounds. 

 

 Move the bands to bookend a small range. In the Mode Estimation Window check 

the Show FRF Fit box, adjust the Extra Term to a value around 10. Click Estimate to 

show an estimated curve fit. This can be seen in Figure 120. 
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Figure 120. Estimated curve fit. 

 

 Increase the number of modes (click Estimate to refresh the curve fit) until there 

is a good curve fit. This can be seen in Figure 121. 

 
Figure 121. Good curve fit in modal estimation. 
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 The natural frequency values corresponding to the modes are listed in the Mode 

Estimation window. To add these modes to the list, click the  button. Move the bands 

to the next area and repeat the curve fit steps. An example of this can be seen in Figure 

122. 

 
Figure 122. Further modal analysis. 

 

 Continue these steps until the modes have been found for the entire area of 

interest. When finished, click File > Save Mode Table in the Mode Estimation Window 

to save the mode table. 

Modal Shape Animation 

 The last step is to animate the structure. Click the Modal Shape Animation link in 

the main window. The following window will open. 
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Figure 123. Modal Shape Animation window. 

 

 In the Structure 3D View Window click the Assign Measurements  button to 

automatically assign the measurements to the DOFs. Click the  button to start 

animation. Adjust the amplitude and speed of animation using the sliders. Click on 

different modes in the Mode View window to animate the modes. To export a movie, 

select the mode to export, set the desired amplitude, pause the animation, then click File 

> Export Movie. The frame rate of the movie is set in the main menu by clicking Operate 

> Options > Structure then adjusting the Frame Rate value. 
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